
USC700 Programmer User Guide

Introduction
Check the label on your USC701. If it starts with;

• S/W 1.06
   then use the USC700 programmer.

• S/W 1.04
   then use the USC105 programmer.

About USC105 Programmer
When installing the USC700 programmer you have the choice to also install the USC105 
programmer.

The USC105 programmer works on USC701 modules with a software version < 1.06 (1.04 most 
common).  The USC700 cannot program the older modules.

Many screens in the USC105 software are identical to the new software however there are major 
differences.

• No integer maths functions in the equation editor and shorted equations.

• Equation length too short for the PID control examples.

• USC105 must be used to program and read 1.04 modules
USC700 must be used to program and read 2.06 modules.

• The logging function has been disabled in USC105, however the USC700 program can log 
readings from all USC701 modules regardless of it internal software revision.

About USC700 Programmer
The USC700 programmer is a 32-bit Windows application used to configure the USC701 for use 
as a signal-conditioning module via the COA703 that provides an isolated connection to a 
personal computer USB port.
USC700 Programmer contains a “New Module Wizard”, this wizard is used to create a USC 
program (module definition).  Most common signal conditioning module types can easily be made
using the new module wizard.
Previously made module definitions are stored in a single data base file on your PC and can be 
opened, closed and copied using the file/open new menu.  Module definitions can also be 
exchanged between systems over the Internet or on floppy disk using the “File/Import/Export” 
commands.
USC700 Programmer has pre-made linearising tables that are selected automatically when 
measuring temperatures from thermocouples and RTD’s however custom tables can easily be 
created and stored within the one USC Program.
The equation editor is used to customise the functionality of the USC701.  Math functions, 
branching commands and control of when the equation is run create a powerful and versatile 
tool.  While the equation editor creates complex functions usually there are one or two variables 
within the equation that you wish the end user to have easy access to.  This is accomplished by 
creating a configurable user interface.
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About the USC701
The Universal Signal Conditioner USC701 is a programmable signal conditioner that combines 
measurement and control functions in a single instrument and provides user selectable solutions 
for most signal conditioning applications.
The USC has the following functional blocks:

• Two analogue inputs that can be programmed to measure ac/dc current or voltage,
resistance, potentiometer, strain gauge and temperature

• Two pulse (digital) inputs that can be programmed to measure frequency or phase 
and also be used as control inputs to perform hold, reset and enable.

• One isolated proportional output that can be configured as an analogue output or a 
pulse output.

• Two relay outputs.
• Excitation outputs.
• Digital (bus) outputs.
• Calibration & set point variables.
• Arithmetic function variables.

The configuration can be set up and altered by:
• The plug-on Access Module AM702 which has a 2 line by 8 character display and 5

push buttons and is menu structured for the selection of input/output/alarm 
variables and selection of calibration information 

• The plug on Computer Adaptor COA703 that interfaces to the users PC that is 
loaded with the USC700 Programmer software. This Software offers a user-
friendly interface for the configuration and setting of a USC.

• A Select switch and encoder are accessible on the top of the USC that allow the 
user to alter a number of calibration parameters: Output zero & span and relay 
set points.
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About the AM702 Access Module
The plug-on Access Module AM702 is menu structured for the selection of input/output/alarm 
variables and selection of calibration information.  The AM702 has four operational modes.

AM702 Run Mode
In run mode one selected variable will be continuously displayed.

• To change the number of significant digits displayed press the ‘BACK’ and ‘NEXT’ keys.

• To display the name of the program (Identity) stored in the USC701 press the two options 
buttons at the same time.

• To display the revision of the AM702 program press the  and  buttons at the same time.

AM702 Configure Mode
The AM702 allows the user to perform changes to the configuration of the USC. These changes 
include:

• The measurement type or function,

• The analogue output type,

• Ranging of the input and output,

• Setting the relay action, trip points and delays

• Setting of sample times and hold functions

AM702 Trim Mode
Trim Mode is used to change selected parameters for each previously programmed input, output 
and equation constant to an operating USC701 without disruption to output function.  The “Trim 
Mode” can be used in conjunction with the “USC700 Programmer” program to create a 
customised user interface for each USC701.

AM702 Hot Key Mode
When Hot Keys have been enabled the USC701 will run alternate custom program branches that 
were written using “USC700 Programmer”.  Any combination of the first four AM702 keys can 
have a custom branch added to the USC701 program.
When hot keys are enabled the AM702 run mode commands are disabled. Hot Keys can be used
in conjunction with the “USC700 Programmer” to create a customised user interface for each 
USC701.

AM702 Display only Function
When “Trim Mode”, “Configuration Mode” and “Hot Keys” have been disabled by the “USC700 
Programmer” PC program all functionally of the AM702 is disabled except for the run mode 
commands.

About the COA703 Computer Adaptor
The COA703 is a piece of hardware that clips on to the top of a USC701 to enable an isolated 
connection between a USC701 and the USB port on a personal computer.
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The USC Wizard and User Input
Take the time to read this before running the walk through. It may be illuminating.

Rule 1
A Red caption over a list box without an accompanying 
button always indicates that an item in the list needs to be 
selected.

Rule 2
If a small command button appears over a list box with a 
red caption then additional settings are required to 
implement the selected option; pressing the small 
command button accesses these options.
Rule 3
A red caption over a text box indicates that the entered 
information is outside the limits or is the incorrect data 
type.
Rule 4
Whenever an error occurs the wizard will stop on the faulty step and display a red 
caption over the problem.  The helper box on the bottom of the screen will also display 
the problem in plain text.
Rule 5
The wizard only saves entered information as the user presses ‘Next’.  Changing 
information and then pressing ‘Back’ will loose the last entries
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Communication and Operation Problems

Problem Solution

Power LED 
Blinks 
Periodically

1. Check for correct supply voltage.

2. Disconnect the input connector (not the power connector).

3. Apply power to the USC701, if the power LED now remains 
permanently lit there is probably too much load on the “EXCIT” 
output for the voltage it has been programmed for, reprogram to a 
lower voltage or change load.

The Run LED Is 
Not Flashing

1. Switch off supply and reapply, check if unit now operates.

2. Check that suitable spike suppression is fitted across contactor 
coils operating from same power source.

Run LED only 
flashes for 5 
seconds after 
switch on

It is possible to create equations that will lock up the USC701.  The 
lock can occur due to an improper equation or an unhappy 
circumstance that occurs during programming (The equation is in use 
while it is being changed).  To return the USC701 to operating state a 
short simple program is downloaded during the power up period.

1. Using the new module wizard make a signal isolator with one input 
one output and no relays.

2. On the “Tools” menu select “Disable Protocol Interlocks”

3. Connect the computer adaptor to the USC701 and switch off the 
power to the unit.

4. Press program.

5. Switch on the power to the USC701; the program should start 
downloading after a second.

6. If process is unsuccessful power down the USC701 and try again.

7. After the USC701 has recovered try suspect program again it may 
be successful or rewrite using an alternate structure.
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My First USC701 Program
T he computer adapter COA703 clips on to the top of a USC701 to provide an isolated connection 
between it and your personal computer.   NEVER connect directly between any APCS signal 
conditioning module and the serial or USB port on your PC

Start the USC700 Programmer
1. Start the program using the icon created 

when the program was installed.

2. After the start up screen and messages the 
program opens, as shown.

3. Double click on ‘New Module Wizard’ or, 
press the ‘New’ command button while 
‘New Module Wizard’ is selected.

4. The ‘New Module Wizard’ will open.

Running the New Module Wizard
1. Select a signal type in the left list, then 

select a range in the right list.

2. Select ‘Temperature’ on the left list, then 
‘Thermocouple’ on the right list

3. After selecting Thermocouple on the right 
list the range label will change from red, to 
the menu text colour.  The ‘Next’ button will 
also have gone from disabled to enabled.
Click ‘Next’ or press Alt + N

4. Select from the list the required input 
thermocouple type.  When a range is 
selected the default properties for that 
range will be entered.

5. Leave entries in their default state, it is 
possible to change other settings at this 
stage but for reasons of clarity we will 
continue as they are. Click ‘Next’ or press 
Alt + N.

6. Click on the 22mA range, and the 
properties for the range will display as 
shown.

• The selected source is 
‘Ch1 0-1000 Deg C’
the output from terminals 11 and 12 will be 
4mA at 0°C and 20mA at 1000°C.
The signal limiting is set outside the range 
unit’s column and will therefore have no 
effect.
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7. Click ‘Next’ or press Alt + N.
Select “Relay 1 On/Off” and enter the upper
trip and lower trip points as 600 and 700 as 
shown.

• With the relay set to direct action as shown it 
will switch on at 700 Deg C after the on delay 
(currently set at 200mSec) and will switch off 
at 600 Deg C after the off delay (currently set 
at 200mSec).

8. Click ‘Next’ or press Alt + N.
Select the System range.  The properties 
displayed are various left over variables and
are not specific to a particular section of the
USC.

9. Click ‘Next’ or press Alt + N.
A message will appear regarding a ‘Verify 
Wizard’.  The "Verify Wizard" will always run
at the end.
Click ‘Close’ or press Alt + C the "Verify 
Wizard" will run and close to the screen 
shown next page.

The USC Properties Screen

 The first column of buttons represents the 
USC inputs.

 The second column of labels M4 to M9 
represents the equation memory outputs; 
by moving the mouse pointer over them the 
expected output range will appear as a tool 
tip.

 The third column of pictorial buttons 
represents the USC outputs.

As the CH1 button is pressed the list box on the
right is displaying CH1propertities.  CH2, P1, 
P2 and RLY2 are all displayed as disabled, as 
they have not been programmed for use.  The 
text box at the top is displaying ‘Temperature 
Thermocouple’, created from the previous 
selections made.

Program the Connected USC
Connect the COA703 to the USC701 and press
program.  It takes between thirty seconds and 
two minutes to program a USC.

• To successfully program a USC the ‘SELECT’
switch on the top of the USC must be in 
position ‘0’.

Open an Existing USC Program 
1. If the ‘New/Open’ dialogue is not open then 

start it by clicking ‘Open/New’ on the ‘File’ 
menu.

2. Select the ‘Open USC’ Tab as shown below
and scroll down to the required existing file 
to open.  The list can be resized and sorted 
by Name, Rec, Serial, Time and Date.  The 
time and date will change every time the file
is accessed.

3. After selecting the required file the ‘USC 
Properties’ screen will open.
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Extending My First Program
Adding Functions to an Existing USC Program

The following procedure will add a frequency measurement to input P1 and set RLY2 to switch on
50 m L/Sec and off at 45 m L/Sec of product flow.
The input will be scaled such that 0 to 20 Hz = 0 to 100 m L/Sec

1. Click the button representing P1 on the ‘USC 
Properties Screen’.  The list box on the right will 
indicate that P1 is currently ‘NotSet’.

2. Click the ‘Configure’ button and the ‘Modify 
Wizard’ will step through to the pulse 1 range 
setting.

3. Click on the small ‘r’ button above the list to add 
the frequency ranges to the list box. 

4. Select type ‘Measurement’ then range 
‘Frequency’.  Press next to close the change 
range wizard.

5. Click on ‘Freq Contact’ to display the properties for setting pulse 1.

6. Enter 0 and 20 in the ‘Range Units’ column.
7. Enter ‘m L/Sec’, 0 and 100 in the ‘Eng.Units’ 

column.

8. Click ‘Next’ then ‘Finish’, the ‘Modify Wizard’ will finish and run the ‘Verify Wizard’ before the new 
properties will be displayed for pulse 1 on the ‘USC Properties Screen’.

9. Click the button representing RLY2 on the ‘USC Properties Screen’.  The list box on the right will 
indicate that RLY2 is currently on range ‘NotSet’

10. Click the ‘Configure’ button and the ‘Modify Wizard’ will step through to the Relay 2 range setting.

11. Click on the small ‘r’ button above the list to add the other ranges to the list box.

12. Click on ‘Relay 2 On/Off’’ to display the properties for setting relay 2.

13. Select the measurement source on the source list box, ‘P1 0-100 m L/Sec’.

14. Select the trip action ‘Direct’.

15. Enter the lower and upper points, 45 and 50.

16. Click ‘Next’ then ‘Finish’, the ‘Modify Wizard’ will finish and run the ‘Verify Wizard’ before the new 
properties will be displayed for pulse 1 on the ‘USC Properties Screen’.
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17. Edit the program name to represent something
more meaningful enter, ‘Head Temperature 
with m L/Sec Alarm’.

Adding Peak Measurement Function to CH1 
The following procedure will take the ‘Head Temperature with m L/Sec Alarm’ program example and 
add a peak measurement function to CH1.  This function could have been added at any time in any 
of the previous example steps, it has been separated here for clarity reasons only.

1. Open the required ‘USC Properties Screen’.

2. Click on the CH1 button to show channel 1 properties in the list box.

3. Click the ‘Configure’ button and the ‘Modify Wizard’ will step through to the Channel 1 
range setting.

4. Select ‘Peak’ in the ‘Ext. Ctrl’ list box as 
shown.

5. Click on the small ‘s’ button above the list to 
add a ‘Reset’ input.

6. The ‘Add in Wizard’ will suggest using P2.
Experiment, select P1 on the range list and 
take note of the error messages.  The wizard 
will allow you to overwrite the function of P1 
however the existing function will be lost.
Select P2 and press ‘Next’.

7. Select contact input set the trigger to required 
state when the ‘Reset’ function is active.

8. Press ‘Next’ then press ‘Close’ to close the ‘Add In Wizard’ and return to the ‘Modify 
Wizard’

9. Click ‘Finish’, the ‘Modify Wizard’ will finish and run the ‘Verify Wizard’ before the new 
properties will be displayed for channel 1

Reading Programs out of the USC701
1. Connect the COA701 on to the top of the USC701.
2. On the USC700 Programmer file menu select “File”, “Read Program from USC”.
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Using Look-Up Tables
About Look-Up Tables
The standard signal conditioner will produce a 
linear output in response to a linear input.  This 
means that when plotting output against input 
on a line chart the result would be a straight 
line.

The USC700 Programmer program has output 
on the vertical axis and input on the horizontal 
axis.

Many measurement applications require the 
input output response to be tailored to correct 
errors in the linearity of the measured signal as 
in the following ‘Shaft Angle Example’.

Shaft Angle Example
A potentiometer is used to measure an aperture opening from 0 to 100%.  As the potentiometer is 
connected using long wires to the signal-conditioning module in a noisy factory environment the 
current flowing through the potentiometer (connected as a two-wire series resistance) is measured 
instead of the voltage.

PROBLEM

 This method of measurement is highly immune to noise but has a non-linear response.

 The aperture measurement of 0 to 100% does not use the full range of the potentiometer

Steps to Solving the Problem

 Run the ‘New Module Wizard’ (‘dc Signal’, ‘Isolator’, CH1 ‘30mA’, Output 1 ‘0-22mA’, Relay 1 
‘Not Set’, ‘System’) and configure an input channel to measure input current and set the auxiliary 
voltage output to a level suitable for driving the potentiometer.  (I used a 5k ohm potentiometer 
with an extra 150 ohm series resistor the auxiliary set to 8Vdc and CH1 set to the 30mAdc range)

 Set the USC to display the input channel (CH1) on the ACCESS module.  On the USC Properties
Screen change the program name from ‘dc Signal Isolator’ to ‘Shaft Angle Example’ and program
the USC.

 Connect the USC into the system to be linearised.

 Move the aperture to different points and record the measurement displayed as shown in 
following table.

 Create a look-up table from measured points to linearise the measurement.

 Update the engineering unit for the new measured output.
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Create A Look-Up Table From Measured Points
The following procedure will add a look-up table to 
CH1 where CH1 is currently set up as 30mA input.  
CH1 is connected to an external device (Aperture 
position) with measurements as shown.

Measured
mA on CH1

Aperture
position %

1.811 0
2.257 25
2.941 50
3.865 75
6.075 100

1. Open the ‘USC Properties Screen’ for the module definition to be changed.

2. Click the CH1 icon then the ‘Configure’ button.  
The ‘Modify Wizard’ will step through to the 
current CH1 range setting.

3. In the ‘Table’ list click on ‘Add table’.  Click the 
small ‘u’ button after it appears above the table 
list.

4. On the ‘Enter Points for Table’ screen click 
‘Create Table From Points’.

5. In the description box enter ‘Aperture Position’.

6. Enter the known points on the grid.

7. After entering the points then press ‘Ok’ to create
the table.

Two points will create a straight line.

Entries are sorted by the input value.

The “Create Table From Points” option will open with the values used to create the last table.

To add rows enter data in the last (empty) row. Press resort to display the values, as they will be used.

To delete rows click in the row, then select the whole row and press delete.

The first row and the last row will contain the maximum and minimum input values or the input range.

The input range entered will be divided into 101 even divisions for use by the USC.  The input range can be
changed after the table is created if required.

8. The ‘Look Up Table’ screen will open.  I clicked on the 
chart line causing the data grid to move to E51.  This 
point shows that input 3.98554 will have an output of 
76.3647.

The input range consists of 101 even points on the x-axis 
the user cannot directly change these ‘In’ values.

The output is plotted in the vertical axis these ‘Out’ values 
can be directly changed by the user.

9. Click the ‘Ok’ button to accept the currently selected 
table for use.

The Min, Max Values and the Engineering Min and Max 
values are entered and locked by the table.

The Engineering units can be changed to reflect the input 
function.

10. Change the engineering units (Eng.Units) to ‘Apert%’ 
and press ‘Next’ until the modify wizard is on ‘Output 1’.
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11. Change the ‘Cal Min.’ and ‘Cal Max’ values to 0 and 
100; this will cause a 4 to 20mA output for a 0 to 100% 
aperture measured at the input.
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Editing an Existing Table
In this example we will copy the module definition made in the previous exercise (‘Shaft Angle 
Example’), then change some points to further tailor the function.

PROBLEM

It was found that after using the ‘Shaft Angle Example’ that there is a mechanical dead spot in the 
middle where the shaft moves but the aperture does not.

When the input is at 30% of the range or 3.0902mA the aperture stays at 54.0368% until the input is 
at 34% or 3.26076 when the aperture starts moving again and returns to the original curve at 36% 
input.

1. Open the ‘USC Properties Screen’ for the module definition to be copied (Select ‘Shaft 
Angle Example’ in list) and select ‘Open’.

2. From the ‘Edit’ menu select ‘Copy’ and change the program to ‘Shaft Angle Example MK2’.

3. Click the CH1 icon then the ‘Configure’ button.  The ‘Modify Wizard’ will step through to the
current CH1 range setting.

4. Click on the small  ‘u’ command to edit the user-defined 
table.

5. On the ‘Look Up Table’ screen click ‘Copy to New’ to retain the original table.  Change the 
description from ‘Aperture position Copy’ to ‘Aperture position MK2’.

6. On the grid move to row E30 and select inside the ‘Mark’
column.  Click on the dropdown button to mark the point.

7. On the grid move to row E34 and select inside the ‘Out’ 
values column and change the value to 54.036.  Now 
select inside the ‘Mark’ column.  Click on the dropdown 
button to mark the point.

8. On the grid move to row E36 and select inside the ‘Mark’
column.  Click on the dropdown button to mark the point.

9. You will now have three points marked, click ‘Join 
Marks’ to update the points in-between, click the ‘Ok’ 
button to accept the currently selected table for use.

10. Press ‘Finish’ to close the ‘Modify Wizard’ and ‘Program’
to down load to new module definition to the currently 
connected USC.
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Import / Export Data
When the ‘USC700 Programmer xxx’ program is installed its default location is 

‘C:\Program Files\USC700 Programmer 1xx\’ where xxx is the sub version number of the internal 
USC software that the program is written for.

User programs are stored in a database located at “C:\APCS\USC700\Run”:

UscConfg.exe Executable

UscRun.mdb Run database containing object definitions

UscData.mdb Saved setting database containing
module definitions, look-up tables, recording sessions and script files.

Reasons to Export Data
1. All work that you do is saved in the ‘UscData.mdb’ file.  If the ‘USC700 Programmer program’ is 

uninstalled (deleted) or copied over then any work you wish to keep may be lost.

2. Exporting module definitions that use look-up tables will export the tables as well as the module 
definition providing insurance against accidental table change.

3. Exported module definitions are small and can be easily emailed.

4. Recording sessions can be exported to a ‘TXT’ file that can easily be read into an EXCEL spread
sheet.

Export A Module Definition
1. Open the module definition required for export and display on the ‘USC Properties Screen’ as the

active window.

2. On the ‘File’ menu select ‘Export USC’.  In the ‘Save As’ dialogue change the file name and save 
location as required and press ‘Save’.

Import A Module Definition
1. On the ‘File’ menu select ‘Import Module Definition’.  In the ‘Open’ dialogue change the ‘Look in’ 

location as required and select a “*.USC” file.

2. Press ‘Open’, a new module definition number is created.  If the module definition used user-
defined look up tables then new table definitions codes will also be created.

Export Recording Session Data
1. Open a reading log that contains some recorded data and display as the active window.

2. On the ‘File’ menu select ‘Export Readings’.  In the ‘Save As’ dialogue change the file name and 
save location as required and press ‘Save’.

Import Readings to Excel
1. Open a blank Excel sheet.  On the ‘File’ menu select ‘Open’.  In the ‘Open’ dialogue change the 

‘Look in’ location as required and type “*.TXT” in the file name box.

2. Select the required file name (created in export session) and press open.

3. On the text import wizard selected ‘Delimited’ and press next.

4. In the ‘Delimiters’ frame select the comma and un-select the other types.  Set the text qualifier on
‘ and press finish.
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Using the Equation Editor
Equation outputs are saved in memory location M4 to M9 or Mem4 to Mem9. The “modify wizard” is then 
used to connect M4 to M9 to the relays, analogue or pulse output.

The equation can also directly manipulate the state of the relays.

The equation editor can perform both floating point and integer maths, when using M4 to M9 to control 
USC701 output components ensure that the result is in floating point format.

The equation editor is used to customise the functionality of the USC701.  Math functions, branching 
commands and control of when the equation is run create a powerful and versatile tool.

Typical applications include:

• Mathematical manipulation of a single input signal.

• Mathematical manipulation based on the values read from multiple inputs.

• Conditional processing of signals based on the state of other inputs.

• Filtering of input signals over long periods by providing a moving average of input signal while
using the fixed equation update time option.

• PID control of a process variable.

• Pulse width modulation of the relays.

Following is a series of exercises designed to familiarise with the user while building some typical 
working applications.

• The “Create a Simple Adder using the New Module Wizard” is a simple exercise that should 
take about three minutes to run and impart entry-level knowledge.  A later exercise “Review 
the Simple Adder Wizard Equation” has a full listing to explain the reverse polish program list 
and how to use the step tool to simulate the equation function.

• The “Creatw a Simple Divider using the New Module Wizaed” is similar to the previous 
example except that it demonstrates some error conditions and how to correct or ignore 
them.  The “Evaluate Equation Outputs” screen is demonstrated as well as one reason to 
disable “Auto Evaluate” feature.

• The “Make an Adder with Peak Output and Low Limit” demonstrates the branching functions 
and uses a control input, branch labels and a constant.
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Create a Simple Adder using the New Module Wizard
1. Run the ‘New Module Wizard’ and select ‘dc Signal’, ‘Adder’ then ‘Next’.

2. Select channel 1 as 10Vdc then ‘Next’.

3. Select channel 2 as 10Vdc then ‘Next’.
4. Select the ‘0..22mA’ output on the range list.

5. Select ‘m4 0..20 Adder’ ([m4] [Min]..[Max] [Engineering Unit]) on
the source list then click ‘Next’.

6. Select ‘Next’ until the wizard closes.

The new module wizard added a simple equation (read CH1, read CH2, add, save Mem4) to the settings of
the module definition that you are creating.

When the USC wizard moved from the input components to the output components the “Auto Evaluator” 
option calculated the expected output range of the equation based on the minimum and maximum 
engineering range of the inputs used.
In this case:  0+0=0, 0+10=10, 10+0=10, 10+10=20
Therefore the maximum expected output range in memory 4 is 0 to 20.

This calculated range is used by the wizard to check limits and set the sensitivity of the ‘ADJ.’ encoder on 
the top of the USC with this range.

When the new module ran it also added the engineering unit for Mem4, “Adder”.  To change the 
engineering unit of the adder to a different value you will need to use the equation editor.

7. Select the ‘Equation’ command button in the ‘USC 
Properties’ screen.  The M4 engineering units will be 
displayed at the top of the properties list.

8. Click the ‘Configure’ button; the ‘Special Function 
Equation Editor’ will open.
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Figure 28 Changing Mem4 Engineering Units With Special Function Equation Editor.

9. Click in the program list on
“Save Mem4” and type in the
engineering unit in the box
provided.

The memory results window displays the equivalent equation made from the program list M(4)=(Ch1 + 
Ch2) and also displays “Auto Evaluate Disabled !!”.

With “Auto Evaluate Disabled!” as shown in figure 28 the expected output range for the equation must be 
entered by the user in the Min and Max boxes provided.

10. In the “Simulation Options” check “Auto Evaluate”, the memory results window will now display
M(4)=(Ch1 + Ch2)
!!Auto Evaluate!! M(4)=0 to 20.
With this option enabled if you change the inputs the expected range from memory 4 will also 
automatically update.

11. Press Ok to close the equation editor.

For a full explanation of the simple adder please refer to “Review the Simple Adder Wizard Equation”
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Create a Simple Divider using the New Module Wizard
1. Run the ‘New Module Wizard’ and select ‘dc Signal’, ‘Divider’ then ‘Next’.

2. Select channel 1 as 10Vdc then ‘Next’.

3. Select channel 2 as 10Vdc then ‘Next’.

The new module wizard added a simple equation (read CH1, read CH2, divide, save Mem4) to the settings
to module definition that you are creating.

When the USC wizard moved from the input components to the output components the “Auto Evaluator” 
option calculated the expected output range of the equation based on the minimum and maximum 
engineering range of the inputs used.
In this case:   0/0=error, 0/10=0, 10/0=error, 10/10=1

Therefore the maximum expected output range in cannot be determined.

4. The “Evaluate Equation Outputs” screen opens due to an equation evaluation error as shown.

Figure 29 “Evaluate Equation Outputs” screen opened due to evaluation error.

5. Either use

a. “Go Back and Avoid the
Evaluation Error”

or
b. “Enter Expected Equation
Output Range”

 to overcome this problem.

 

a. Go Back and Avoid the Evaluation Error
a1. Click cancel on the “Evaluate Equation Outputs” screen, an information screen will open warning 

that the output range for the memories has not been updated.

a2. Click ‘Ok’ to close the information screen.  The program will return to the “dc Signal Divider” 
wizard.

a3. Click “Back” until the “dc Signal Divider” wizard is on the 
Channel 2 screen.

a4. Change the ‘Min Value’ from 0 to 0.5 and press the copy 
across button to change the ‘Eng. Min’ to 0.5

This change does not affect the measured value.

The divider wizard created a simple equation CH1/CH2, changing the minimum value of CH2 to 1 prevents
the divide by zero error.
0/1=0, 0/10=0, 10/1=10, 10/10=1
Therefore the maximum expected output range is 0 to 10.

a5. Click next, the wizard will now move to the output components without stopping.
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b. Enter Expected Equation Output Range

The wizard will stop on the “Evaluate Equation Outputs” screen if;
> the auto evaluate option is switched on and the equation simulator cannot determine the output range;
> the engineering range for a used memory has never been entered;
> the trim menu has been enabled, giving the operator the opportunity to change the values of some 
equation constants.

If the equation output does not auto evaluate you must enter the output range for each memory.

In the divider example CH1/CH2 will produce a larger number as CH2 approaches zero.

With this in mind I chose some numbers as follows;
  Minimum: 0 / [any number] = 0
  Maximum: 10 / 0 =  however if CH2 never goes below 0.5 the maximum output range is 0 to 20 
(conditional).

b1. On the “Evaluate Equation Outputs” screen enter the values that you have determined for M4 
minimum and maximum. 

The wizard checks limits and set the sensitivity of the encoder using the range YOU enter.

The range entered will not affect the calculation when the USC operating.

b2. Click next, the wizard will now move to the output components.
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Review the Simple Adder Wizard Equation
1. Create a module definition file using the instructions in “Create a Simple Adder using the New 

Module Wizard”.

2. Select the ‘Equation’ command button in the ‘USC Properties’ screen then click the ‘Configure’ 
button; the ‘Special Function Equation Editor’ will open.

3. Check the ‘Auto Evaluate’ option.

Figure 32 Special Function Equation Editor With A Simple Adder Program.

The ‘Program List’ displays the equation commands in the order that they are used.

To enter ‘(4 + 5) x (3 + 4)‘ into the equation editor in reverse polish; 4, Enter, 5, +, 3, Enter, 4, Enter, +, x.

In ‘Edit’ mode the ‘Calculator Stack’ and ‘Memory results’ windows display program execution based on the
control state and branching options (don’t get too up tight about what this means).

The memory results is displaying a simulation of the equation that produces an output at memory 4‘

4. Click on the first item in the ‘Program List’,  ‘Read CH1’ the engineering unit and range appear for
CH1.

5. Click on the second item in the ‘Program List’,  ‘Read CH2’ the engineering unit and range 
appear for CH2.

6. Click on the fourth item in the ‘Program List’, ‘Save M4’ the engineering unit and range for M4 
can now be changed if required.

7. Select Mode = Step. 

8. As the “Step >” button is pressed 
equation operation is simulated as 
shown.  Pressing “Step >” six times will 
move the simulation to the exit command
where it will stop.

Note that the memory results window is 
empty until the program reaches a save 
command.

Program 
List

Calculator 
Stack

Memory 
Results

Read CH1 S(1)=CH1

Read CH2 S(2)=CH2

S(1)=CH1
Add S(1)=(CH1 + CH2)

Save M4 S(1)=(CH1 + CH2) M(4)=(CH1 + CH2)

Send M4 S(1)=(CH1 + CH2) M(4)=(CH1 + CH2)

Exit S(1)=(CH1 + CH2) M(4)=(CH1 + CH2)
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9. Figure 33 shows the simple adder in step mode evaluated to 6 meaning that the equation 
evaluator performed six steps to get to the current screen.

Figure 33 Simple Adder In Step Mode

The value of all memory results are only reported if they are different 
from their corresponding initial values.

10. By changing the initial value of CH2 to 5 as shown will instantly 
simulate the outputs expected up to the current step number.

Remember the calculated result of M4 was not shown in step 9 as the 
calculated result was the same as the initial value.
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Make an Adder with Peak Output and Low Limit
This exercise will take the previous input adder example and add a peak measurement output that is 
reset to a minimum output level (4) when a digital input is active.

Create some program documentation.

11. Enter the equation screen and click on the ‘Show/Edit user description’ option.

12. In the ‘Helper’ window type in following information to describe the variable use in the equation to
be written.
Adder with Peak Output And Low Limit
Mem 4 = Adder Output
Mem 5 = Peak Output
Const b = reset value for peak output
P2 = reset the peak output to Const b

Create a block of commands that saves memory 4 in memory 5

13. In ‘Edit’ mode click on the <End> label, click ‘Branch’ on the keypad and insert an ‘Exit’ 
command.

14. While still on the <End> label, click ‘Branch’ on the keypad and insert a ‘Line Label’.  When 
prompted enter the name of the line label as “SavePk”.

15. While still on the <End> label, click ‘Read’ on the keypad and insert a ‘Read M4’ command.

16. While still on the <End> label, click ‘Save’ on the keypad and insert a ‘Save M5’ command.

17. While still on the <End> label, click ‘Send M?’ on the keypad and insert a ‘Send M5’ command.

Create a block that saves constant ‘b’ in memory 5

18. While still on the <End> label, click ‘Branch’ on the keypad and insert a ‘Exit’ command.

19. While still on the <End> label, click ‘Branch’ on the keypad and insert a ‘Line Label’. When 
prompted enter the name of the line label as “ResetPk”.

20. While still on the <End> label (shift button up ), click the ‘Constant’ button on the keypad and 
insert ‘Constant b’.
When prompted enter the value as 0 and the name as “ResetVal”.

21. While still on the <End> label, click ‘Save’ on the keypad and insert a ‘Save M5’ command.

22. While still on the <End> label, click ‘Send M?’ on the keypad and insert a ‘Send M5’ command.

Insert a branch that saves constant b in memory 5 when P2 is pressed.

23. Click on the first exit command in the program list.

24. Click ‘Branch’ on the keypad and insert ‘If P2 Goto’ command.  Select line “ResetPk” when 
prompted.

Insert a branch that saves memory 4 in memory 5 when memory 4 is greater than memory 5.

25. Click on the first exit command in the program list.

26. Click ‘Read’ on the keypad and insert a ‘Read M5’ command.

27. Click  on the keypad.

28. Click ‘Branch’ on the keypad and insert ‘If > 0 Goto’ command.  Select line “SavePk” when 
prompted.

Save results so far.

29. Press ‘Ok’ to exit then ‘Ok’ to close and save changes, the following message will appear.
P2 has been used in the equation editor but it has not been enabled for use.
Please enable when the ‘modify wizard’ opens.
Pressing cancel will disable all further checks of the equation in this pass.

30. Press ‘Ok’, when the P2 not set screen appears press the small range button ‘r’ and select 
‘Logical’ then ‘Settings’ on the change range wizard.  Press Next to return to the modify wizard.
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31. Select ‘Contact’ from the list.  Change the trigger to ‘High’ so that the P2 function occurs when 
the button is pressed.

32. Press “Next” then “Finish”.  When the ‘USC Properties’ screen appears press ‘Configure’ to re-
enter the special function equation editor.

33. In the ‘Select Mode’ group select ‘Step’.

34. Progressively press the “Step >” (step next) button.  The function of the equation will be 
simulated as shown in figure 36.
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Figure 36 Adder with Peak Output and Low Limit Equation List

Program List Calculator Stack Memory Results

Read CH1 S(1)=CH1

Read CH2 S(2)=CH2

S(1)=CH1

Add S(1)=(CH1 + CH2)

Save Mem4 S(1)=(CH1 + CH2) M(4)=(CH1 + CH2)

Send M4 S(1)=(CH1 + CH2) M(4)=(CH1 + CH2)

If P2 Goto ResetPk S(1)=(CH1 + CH2) M(4)=(CH1 + CH2)

Read Mem5 S(2)=(MEM5

S(1)=(CH1 + CH2)

M(4)=(CH1 + CH2)

Subtract S(1) =(CH1 + CH2) – MEM5 M(4)=(CH1 + CH2)

If> 0 Goto SavePk S(1) =(CH1 + CH2) – MEM5 M(4)=(CH1 + CH2)

Exit M5 remains the same

LAB: SavePk S(1) =(CH1 + CH2) – MEM5 M(4)=(CH1 + CH2)

Read Mem4 S(2) = MEM4

S(1) =(CH1 + CH2) – MEM5

M(4)=(CH1 + CH2)

Save Mem5 S(2) = MEM4

S(1) =(CH1 + CH2) – MEM5

M(5)=MEM4

M(4)=(CH1 + CH2)

Send M5 S(2) = MEM4

S(1) =(CH1 + CH2) – MEM5

M(5)=MEM4

M(4)=(CH1 + CH2)

Exit

LAB: ResetPk S(1)=(CH1 + CH2) M(4)=(CH1 + CH2)

Con_ b S(2)=Con_b

S(1)=(CH1 + CH2)

M(4)=(CH1 + CH2)

Save Mem5 S(2)=Con_b

S(1)=(CH1 + CH2)

M(4)=(CH1 + CH2)

M(5)=Con_b

Send M5 S(2)=Con_b

S(1)=(CH1 + CH2)

M(4)=(CH1 + CH2)

M(5)=Con_b

Exit
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Interfacing with the Access Module
This manual applies to:

AM702-02 Plug on configuration module

“USC700 Programmer” PC based configuration software

Compatibility with the AM702
1. Any USC701 module programmed with an AM702-02 in configure mode can be read into the PC 

using the “Read Program from USC” command.

2. When USC700 programs a USC701 it tests the data:

• If the program could have been made by the AM702 then the various flags are set within 
the USC701 for the configure mode to operate on the pre-set menu items.

• If the program could not have been made by the AM702 then the “configure mode” flags are
set to PC Special.

3. USC701 modules programmed as PC Special can still be modified using the AM702-02 in Trim 
Mode.

Configurable User Interface
The USC700 Programmer can create customised USC701 configurations far beyond the 
capabilities of the AM702 Configure Mode.
USC700 Programmer can flag variables that you want the operator to change using the AM702-
02 access modules.  Variables and settings that you wish to protect from user scrutiny can be 
disabled.  The USC700 Programmer can also enable or disable the main categories in the trim 
menu.  Disabled menus, settings and constants do not appear when scrolling through the AM702
trim menu.
As the customised interface is stored within the USC701 the same AM702 can be used to trim 
many different applications.

The “Create a Divider with Trim-able CH1 Minimum Value” example will:

 Create an input divider CH1/CH2.

 Add a trim-able constant will be added to set the minimum output out of CH2.

 Set the AM702 interfaces to only allow the trim menu.

 Set the trim menu categories such that only constant d and RLY1 trip points can be adjusted.

 Add a helper prompt that will appear on the “Evaluate Equation Outputs” screen.

After completing the “Create a Divider with Trim-able CH1 Minimum Value” example hot keys will be 
added to allow the user to display more than one memory variable.

The “Add Hot Keys to Control Branching” example will:

 Allow the user to display CH1 when keys  and  are pressed.

 Allow the user to display CH2 when keys  and  are pressed.

 Allow the user to display M4 when keys  and  are pressed.

The example shown is used to control the displayed variable however they could be used for running
self test procedures, automatic input calibration or switch to complete alternate programs.
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Create a Divider with Trim-able CH1 Minimum Value

The first step is to create the USC program.

1. Follow previous example “Create a Simple Divider using the New Module Wizard”

2. When the error message occurs due to the divide by zero follow option  “b. Enter Expected 
Equation Output Range” to overcome this problem.

3. After the module definition has been created select
the equation button on the bottom of the properties
screen then select configure.

4. Now in the equation editor click on the divide 
command in the program list as shown.

5. Click the ‘Constant’ button on the keypad and 
insert ‘Constant d’.
When prompted enter the value as 0.1 and the 
name as “CH2 Min” and press ok.

6. With the divide command in the program list still 
selected click the ‘MAX’ button on the keypad.  
The resulting program is shown.

7. In the simulation options enable ‘Auto Evaluate’.

8. Click on “Show/Edit user description” and replace the description in the helper window with 
“Enter the minimum value for CH2, it must be greater than zero.”

9. Press ok to close the equation editor.

10. The modify wizard may stop on the output components due to out of range errors, correct these 
and continue the USC properties screen.
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The second step is to enable and disable parameters to be trimmed.

11. Select the AM702 button and 
press configure, the Configure 
AM702 Trim Mode Screen will 
appear.

12. Un-tick all main options except 
“Enable Trim Menu”, “Constants” 
and ‘Con_d’.  The resulting 
screen should look the figure 
opposite.

13. Press OK to close.

The third step is to test the constant 
trim function using the “Evaluate 
Equation Outputs” screen.

14. On the USC properties screen 
select the output button and press
configure.

When the USC wizard moved from 
the input components to the output 
components the AM702 trim 
constants option is checked causing 
the “Evaluate Equation Outputs” 
screen to open.

15. Constant d and its name “CH2 Min” appears and is enables for edit.  As the value is changed the
auto evaluate option determines the output range based on the engineering range of CH1 and 
CH2.  Also the helper text  “Enter the minimum value for CH2, it must be greater than zero.” 
Appears in the <User Description > section of the helper window.

The fourth step is to program the USC701 with the appropriate inputs connected.

16. After programming the USC701 remove the COA703 from the top of the USC701 and fit a 
AM702-02.

17. The AM702-02 will continuously display the selected variable while in run mode.

18. Press enter on the AM702, the trim menu will load and display ‘Trim Constant’.

19. Press enter the AM702 will display ‘CH2 Min’ and its value.

20. Press enter again to edit the value of constant d then press enter twice to return to run mode, the
effect of the change you made can be seen when the input to CH2 is at zero volts.

NESS Corporation
APCS division

USC700 Programmer User Guide
Drawing:  MA70316 Issue: 6 10/02/21

Tel: (02) 8825 9295 www.apcs.net.au
Page: 27



Add Hot Keys to Control Branching

 The AM702 will display CH1 when keys  and  are pressed.

 The AM702 will display CH2 when keys  and  are pressed.

 The AM702 will display M4 when keys  and  are pressed.

1. This example follows the previous example “Create a Divider with Trim-
able CH1 Minimum Value” however the same logic can be applied to 
any program.  The complete program listing from the previous example 
is shown.

2. Select line <End>, press “Branch” then “Insert Line Label” and type 
“ShowCh1” when prompted.

3. While still on <End> press “Display” then select display CH1.

4. While still on <End> press “Branch” then select “HotK off”.

5. While still on <End> press “Branch” then select “Exit”.

6. Select the first exit command in the list as shown above 
and press “Branch” then select “Insert If HK1000-”

7. Select the required key code on the assign hot keys 
dialogue (CH1 = HK1001, CH2 = HK0101, M4 = 
HK0011).  The correct key code for channel 1 is 
displayed on the diagram opposite.

8. Press OK and select the line label to jump to when the hot key is 
pressed.

9. Repeat steps 2 to 8 substituting the line label names and key codes for 
each.  The new lines should look like the listing opposite.

10. Press OK to save and exit the equation.

21. On the USC properties screen select the AM702
button and press configure.  On the ‘Configure
AM702 Trim Mode’ screen select  ‘Enable Hot Key’
as shown.

22. Program the USC701 then fit an AM702-02.

23. The AM702 will start in run mode, by pressing the
predefined key combinations the display will change to the appropriate 
variable.

24. Pressing enter will load the trim menu and still operate according to the 
previous.  After exiting the trim menu hot keys will resume control.

TIP the engineering unit for both CH1 and CH2 are both “Vdc” this may be confusing.  Changing channel 1 
to “CH1 Vdc” and channel 2 to “CH2 Vdc” will provide visual feedback to which channel is displayed
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Using Integer Maths
The USC701 has four memories CH1, CH2, P1 and P2 (M0 to M3) that contain input measurements,
these measurements are floating point numbers.

The output devices O1 (mA, V, PWM, Frequency), RLY1 and RLY2 can be controlled from M0 to M9
(memory’s).

The values in M0 to M9 must be floating point numbers to control the output devices correctly.

There are two problems that occur when using floating-point maths in custom applications:

 Floating point arithmetic requires more cycles of the CPU and therefore takes more time to 
complete.  Each floating-point addition / subtraction takes about 2mS while each floating-
point multiplication / division takes about 5mS.

 Testing for a particular value can be risky as simply starting at 0 and adding 1 progressively 
will not result in exactly whole numbers in every case, some will be ever so slightly lower than
the whole number while others will be ever so slightly higher than the whole number.

The equation editor has commands to branch on the condition of P1 and P2 making it possible to 
implement different processing based on the condition of the input.  By setting the equation update 
time to a known value this same technique can be used for counting and period measurement 
functions with resolution and speed limitations.

When using the user equation at the maximum update speed of 5mS care must be taken to ensure 
the equation can be processed within that time.  Obviously floating-point division and multiplication 
are out of the question while one or two floating-point addition and subtractions are possible.

Another problem that can occur at fast update times is excessive use of the send memory command.
The send memory command is not required for USC701 output components to use the values in 
memory.  If M4 was connected to the milliamp output and the equation contained no send M4 
commands the milliamp output will still be updated each time the equation is run.

If using a field bus card or logging results with the COA703 the values in M4 to M9 do require the 
send memory to occur.  For applications running at up date times faster than 40mS then extra 
branching should be added to send values say once every eighth time or 40mS as shown in the 
following example.

The following example also features:

 Integer maths is used to calculate values for use in the equation at power up.  This technique 
can be used to free up the equation constants for use in the user interface.

 Integer variables are directly controlling program branching.  Three logical decisions are 
available after the variable is read into the stack, “=Int0”, “>Int0” and “<Int0”.

 Integer counter variables are used to generate the output values due to their very fast 
calculating time.

NESS Corporation
APCS division

USC700 Programmer User Guide
Drawing:  MA70316 Issue: 6 10/02/21

Tel: (02) 8825 9295 www.apcs.net.au
Page: 29



Integer Maths and Branching Demonstration
To follow this application import UAP1052 “Variable Period Triangle Generator“ from the USC centre on the
APCS web site.

Complete understanding of the provided application is not necessary as the following is a guide to using 
the step mode to test program branches independently.

Channel 1 is connected to a potentiometer and has 
been scaled to produce 1 to 10 (period in seconds) 
when moved from 0 to 100%
Memory 4 drives the milliamp output and is scaled to
produce 4 to 20mA out for an input of 0 to 10000.
The setting of channel 1 was moved every 4 
seconds during the recording resulting in changes to
the triangle period.

Referring to the flow chart the program is made up of three main branches that are called base on 
the value of variable 00.

Figure 47 Flow Chart Integer Maths and Branching Demonstration
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Simulating The Power On Branch
1. Open UAP1052 click on “Equation” then “Configure”.
2. In the “Select Mode” frame click step.
3. Click the “Step >”
4. When asked if Var00 =0 press “Yes”
5. The program list will jump to the beginning of the “IsPowOn”

branch.
6. Press “Step >” until the “Step >”button will no longer operate.
7. The program will have completed the “IsPowOn” branch and the

“CalcVals” branch as shown in figure 48.

Figure 48 Results Of the Power On Branch

At switch on the value in Var00 is float 0, therefore when the power is first applied to the USC701
the “IsPowOn” branch will run. From Var0 other values are calculated for use in the other 
branches of the equation.

Power On Branch Calculations (IsPowOn)
Name Label Use Initial Value Calculated

Var00 DwnOnUp Main branch flag Float 0 Int +1

Var01 =Int 1 Fixed value after power on. Float 0 Int +1

Var02 H=Int10k Fixed value after power on. Float 0 Int 10000

Var06 = Int 0 Fixed value after power on. Float 0 Int 0

Var08 = Int -1 Fixed value after power on. Float 0 Int –1

Var10 =Int 100 Fixed value after power on. Float 0 Int 100
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Before continuing to the ‘Is Going Up’ branch remain in the current step position (evaluate to 95) 
and type in the initial values plus data type to be used for V1, V2, V3, V5, V6, V8, V10 as shown 
in figure 49, leave V0 as float 0 for a moment.

Figure 49 Only Values That Are Different To The Initial Values Are Reported

It can be seen that only V0 is now reported, as
all other values are the same as the initial value.

Now change V0 to integer 1 the error message
is reported as the simulator is running the power
on branch with an incorrect data type for the
Var00 calculations.
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Simulating The Up Branch
If still in step mode from previous procedure “Simulating Power On Branch” then reset the step 
counter by;

 > Selecting “Edit” in the select mode frame

 > Reselecting “Step” in the “Select Mode”, if prompted to “Move To Last Step Position” select “Cancel”.

8. Enter step mode end type in the power on values V1= Int 1, V2 = Int 10000, V6 = Int 0, 
V7 = Int 0, V8 = Int -1, V10 = Int 100

9. Press step, when asked at program list 2 “Is Var00=0” select no.
10. Press step, when asked at program list 3  “Is Var00>0” select yes

11. .Press step until the program list has reached line 31, these 
steps will read the last value of Var07 (Integer value 
representing the output) and increase it by Var03 (required step
size for current input setting).

12. The memory results screen shows the
calculated values to this point.

13. Each time the equation runs the “IsGngUp”
branch will continue to run until Var07 reaches
the value of Var02 at which time the “StartDwn”
branch will run.

14. To simulate multiple operation of the equation to the current 
point, change the value of V7 in the “Initial Values Used In Step 
Equation Evaluation”. V(7) in the evaluation results screen will 
increase by the step size.

Each time the equation is run the resulting value in Var07 is converted to a floating-point number and 
saved in memory 4 for use by the USC701 output components.
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Simulating The Down Branch
If still in step mode from previous procedure “Simulating The Up Branch” then reset the step counter by;

 > Selecting “Edit” in the select mode frame

 > Reselecting “Step” in the “Select Mode”, if prompted to “Move To Last Step Position” select “Cancel”.

15. Enter step mode and type in the power on values V1= Int -1, V2 = Int 10000, V6 = Int 0, 
V7 = Int 10000, V8 = Int -1, V10 = Int 100

16. Press step, when asked at program list 2 “Is Var00=0” select no.
17. Press step, when asked at program list 3  “Is Var00>0” select no.
18. Press step, when asked at program list 4  “Is Var00<0” select yes.

19. Press step until the program list has reached line 11, these steps 
will read the last value of Var07 (Integer value representing the 
output) and decrease it by Var03 (required step size for current 
input setting).

The memory results screen shows the calculated values to this point, 
note that the equation has been evaluated to step 11, this is not the 
program list number but how many equation operations
have occurred to get to the current point.
Each time the equation runs the “IsGngDwn” branch will
continue to run until Var07 <= 0 at which time the
“StartUp” branch will run.
To simulate multiple operation of the equation to the
current point, change the value of V7 in the “Initial
Values Used In Step Equation Evaluation”. V(7) in the evaluation results 
screen will decrease by the step size.
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Recording Readings
In general there are three possible methods to record readings coming from the USC701:

1. The optional field bus card can be configured for ‘Modbus’.  A ‘Modbus’ controller could then 
periodically query the USC701 memories and record the records.

2. The optional field bus card can be configured for ‘Serial Talk Only’.  Under this mode user 
specified USC701 memories are sent out the field bus serial port at a user specified interval.  
No controller is necessary; any product capable of capturing serial data could store the 
results.

3. The third method works with all standard USC701 modules this is recording data from the 
COA703 connection using ‘USC700 Programmer’.

USC700 Programmer can record readings from the USC701 and is intended for use when fault 
finding.  It does require full time use of a windows pc so is probably not appropriate as a permanent 
solution.  Some enhancements have been made in version 106 as there has been a lot of interest in 
using the ‘Readings Log’.

The readings log screen although intended to record data is more commonly used to view all channels of 
the USC (inputs and memory’s) at the same time.

Creating a New Readings Log
The following example is recordings values from a USC701 programmed with UAP1052.  A potentiometer 
is connected to CH1 and the mA output O1 is connected back to the mA input on CH2.

1. On the ‘Open/New’ screen double click on ‘New 
Readings Log’ or, press the ‘New’ command 
button while ‘New Readings Log’ is selected.  
The record properties screen will appear as 
shown.

2. In the name of recording box enter a description 
that you would use to later recall the results if 
required.

3. Enter the maximum number of records to be 
recorded = 500 (use between 10 and 99999).

4. Enter how often a record is added = 50mS, this 
recording time should be set while considering 
how fast the measured value is expected to 
change.  Multiply this time by ‘Max No Records’ 
to determine how long the recording will take to 
complete.

5. Select ‘Stop on maximum no of records’.  The continuous option will overwrite the oldest 
readings and therefore never stop recording.

6. Press ‘Record Replace’ and adjust the potentiometer on CH1 to read ‘2.5 Per S’.

Because I am recording values from UAP1052 the output is expected to change every 5mS however this is
beyond the measurement speed of the USC701 20mS and of the recording equipment of 50mS.  This 
means that when the application is set at maximum speed some data will be lost.

7. After 25 seconds the recording will be complete, select 
‘Chart Readings’ and check A2 and M4 for display only 
as shown.

8. The X and Y buttons are used to zoom in on particular 
areas of the chart. 
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9. The X-axis zoom can also be achieved using point and 
click. Using the mouse left click the first point of interest
(you must click on a charted line).

10. Move along to the next point of interest, hold down the 
shift key and left click again.  The ‘X Axis Settings’ 
dialogue will appear with the required settings entered, 
press ok to continue.

11. The resulting chart shows a delay between M4 and 
CH2, this is the combined response time of the output 
and CH2.

PID Control
USC700 contains a wizard to create programs for the USC701.  These programs are easy to 
make and enable technicians with no programming experience to create a large variety of signal 
conditioning modules from just one module.
This guide is intended for end users and technicians to enable them to create a standard 
USC701 PID controller and tune the PID variables.
This process contains the following stages:

1. Use the PID wizard.
2. Use the modify wizard to change the input calibration to any special sensor types.
3. Program the USC701
4. Create a readings log for use while tuning.
5. Run the plant or process and tune PID values.
6. Modify the created program to add extra functions that may be required.

Step 1 Use the PID Wizard
1. Start the new module wizard in ‘USC Config 

106’ by selecting ‘File’ > ‘Open/New’ > ‘New 
Module Wizard’ 

2. Select PID on the type list then select the 
required inputs on the range list.

3. In this example I will select the third item to 
create the following example.

a) CH1 = Measurement input Pt100 20 to 50 
deg range.

b) CH2 = Manul control of output heating 
from 0 to 100%.

c) Controller setpoint is entered into a 
constant using an AM702 in trim mode or 
‘USC Config 106’ in trim mode.

d) Input P2 is used to switch from auto to 
manual control.

When selecting items on the range list 
the above information is listed in the 
helper screen.
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4. Press next, the measurement input is 
presented first, however the Pt100 range is 
not available at this stage, this is changed 
later. Select the 30mA range and change the 
engineering units column to reflect the 
required input calibration as shown.

5. Press next; the manual input is now 
presented. Only the pot input range is 
available, this is changed later. The 
engineering units of the manual control are 
always in percent.

6. Press next; the Auto/Manual control switch 
can now be defined. 

 

7. Press next; the evaluate equation outputs 
screen is presented with instructions in the 
window below. ScaleMin and ScaleMax must 
now be changed to roughly match the output 
control range.  As rule of thumb enter in the 
same range as the measurement input in this 
case 20 and 50 as shown.
The setpoint and initial PID valued can also be
set at this stage.

8. Press OK and select the required controller 
output.  The PID equation output is M7 and is 
always scaled in percent.

9. Press next until the main prosperities screen 
appears.
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Step 2 The Modify Wizard
10. Select CH1 as shown then press configure.

11. Click the small ‘r’ button to change the range 
on channel 1.

12. Select type = temperature, range = RTD 2W 
then next

13. Click on the required input range as shown.

14. Press next until the main prosperities screen 
appears.

15. Click on the AM702 button then configure, the 
following screen will appear

16. Uncheck ScaleMax and ScaleMin to prevent 
them from being changed during the tuning 
process.

All the PID wizards define hot keys for 
use with the AM702.  The keys are 
defined as the following where 
appropriate.

KEY Description 
UP Display measurement 

input
DOWN Display setpoint.
BACK PID Out%
NEXT Display position of 

manual input in percent.
ENTER Goes to trim menu to 

adjust required flow rate 
and Trim menu.

Step 3 Program the USC701
17. Program the USC701 with initial PID parameters Set ‘PB (%)’ = 200, 

‘I time S’ = 50, ‘D time S’ = 0
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Step 4 Create Readings Log
The PID controller can be tuned without
using the readings log.  Also if the 
correct or close parameters are known 
for the plant no tuning is necessary.
The readings log screen can chart the 
last 100 readings while still collecting 
new readings.

18. Start a recording session in USC700 by 
selecting ‘File’ > ‘Open/New’ > ‘New Readings 
Log’

19. On the store readings screen adjust the 
‘Record every’ setting so that the expected 
response of the plant can be viewed in 100 
readings.  I selected 400mS so that a plot of 
the last 100 readings will cover the last 40 
seconds.  Leave on continuous loop and press

record. 

20. Press record replace.

If attempting to tune a very slow system
with a response oscillation of an hour or
more it may be more practical to record
more readings and set to stop on 
maximum number of records.

Step 5 PID Tuning
21. Run plant and reduce PB% until control 

oscillates or increase until control stops 
oscillating.  If the plant has a manual control 
mode run in manual control and check that the
measurement input is reading the correct 
values. The current values stored in the PID 
controller can be viewed on the readings log 
screen.

22. Click the chart readings tab to chart progress

In my example the set-point is set at 40
deg, the input measurement is about 30
and slowly increasing.
As the PID output M7 increases the 
measured input follows with a delay. 
Eventually the measured input will 
reach the set-point as long as the load 
does not change quicker than the 
correction signal.

23. On the edit menu select ‘Trim Constants’

This screen will allow only the constants that 
have been enabled for the AM702 trim menu 
to be changed.
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24. As my plant is responding slowly with no hint 
of oscillation I will progressively reduce PB% 
until oscillation occurs.

When changing the PID parameters the
setpoint should also be changed.  This 
ensures that the true affect of changing 
the parameters is apparent.

25. I changed by PB to 100 and setpoint to 30 
then pressed send on the trim constants 
screen resulting screen.

26. It can be seen that the plant quickly adjusted 
to near the setpoint with some oscillation.

Tuning from here on depends on the 
type of response you want, quick and 
hard with overshoot, slow and soft no 
overshoot or somewhere in-between.

27. I changed by PB to 120 and setpoint to 40 
then pressed send on the trim constants 
screen resulting screen.

I now un-clicked the M7 check box to 
remove the PID output trace.

28. I changed the ‘I time S’ to 10 and the setpoint 

to 30. 
The reduction in the ‘I time S’ value caused 
the integration effect to correct to the setpoint 
quicker

Do NOT make ‘I time S‘ = 0.

29. I now did a rule of thumb ‘D time S’ setting 

from the equation D≃ 1
4×i

where ‘I time S’ = i and ‘D time S’ = D.
I set ‘D time S’ to 0.025 and changed the 
setpoint to 40.

Notes
When ‘PB (%)’ = 100 the gain in the system is = 1

When ‘PB (%)’ = 50 the gain in the system is = 2

When ‘PB (%)’ = 200 the gain in the system is = 0.5

The proportional band  (‘PB (%)’) will affect how savage the control action is. If slower more gentle 
control action is required then higher numbers should be entered into ‘PB (%)’.

To prevent long correction times during start up the ‘I time S’ value is reduced by a factor of 10 
during large proportional errors, this can result in too much spring during start up in responsive 
control systems. Increasing the ‘I time S’ by as little as 0.5 can overcome this problem.
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